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Product and Company Information 

The information in this document is confidential proprietary information belonging solely to Constellation 

HomeBuilder Systems, Inc., a wholly owned subsidiary of Constellation Software, Inc. This document is 

supplied under a license and may not be reproduced, published, or disclosed without prior written 

authorization. Constellation licenses its program products (software) to the customer in accordance with 

the terms and conditions of the BuildTopia Software License Agreement. No title or ownership of the 

BuildTopia software is transferred. Any use of the software beyond the terms of the aforesaid license, 

without the prior written authorization of Constellation, is prohibited.  

 

 

The names of companies, products, people, characters and/or data mentioned in screens, reports, and 

other data examples are fictitious and are in no way intended to represent any real individual, company, 

product or event, unless otherwise noted. Any rights not expressly granted herein are reserved.  

 

 

Trademark and Patent Information  

Other product and company names mentioned herein might be the trademarks of their respective owners.  

 

 

Disclaimer of Warranties and Limitation of Liabilities  

The staff at Constellation has taken due care in preparing this information; however, nothing contained 

herein modifies or alters in any way the standard terms and conditions of the BuildTopia License 

Agreement by which the product was acquired. Nor does it increase in any way Constellation’s liability to 

the customer. In no event shall Constellation or its affiliates be liable for incidental or consequential 

damages in connection with or arising from the use of the product, the accompanying documentation, or 

any related materials.   
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Contacting Support and Services  

Support for the BuildTopia software is available at Constellation’s Baltimore and Markham offices.  

 

 

Baltimore Main Office  
Telephone:  1 410 843-3800 

Fax:   1 410 843-3853  

Web:  http://www.constellationhb.com  

 

 

Support Desk  
Support Desk assists with software operations.  

 

Telephone: 1 800 411-2020 Option #4 

Email:  support@buildtopia.com  

Hours: Monday through Friday 9:00 a.m. to 5:00 p.m. (Eastern Standard Time) 

 

Professional Services  

Contact your company’s Professional Services Consultant for assistance with software implementation, 

training, consulting, and data building. 

  

Telephone: 1 905 475-2209 or toll-free at 1 888 723-2222  

Fax:  1 905 475-7204  

Web:  http://www.constellationhb.com 
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Enhancements 

This section highlights new features and enhancements that have been added to BuildTopia. Each item is 

identified by a ticket and / or defect number (where applicable) which tracks to our internal support and 

software development system. The product versions affected are listed with each item. There is also a 

description of the item with any relevant screenshots to detail the enhancement. 

 

Revised calculation and display of Canadian taxes and rebates on sales agreements 

Defect #:  001-00-1-9072 

Ticket #:  001-00-149090, 001-00-150961 

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   The calculation and display of Canadian General and Provincial Sales taxes and rebates on 

sales agreements has been updated across the sales modules. The calculation of tax will 

now be automatically based on the province for the selected lot, and the rebate will be 

calculated if the sales is for a primary residence, and the price falls under the appropriate 

limit. The workup screens have been updated to display sales pricing before and after tax. 

In cases where the buyer is targeting a specific final price, that price can be entered, and 

a reverse calculation will be performed to determine the differential or delta that is needed 
to arrive at the desired final purchase price. 

*This functionality covers provinces that have the same GST and PST rates as Alberta and 
Ontario. Other provinces will be added in a future release. 

Screenshots:  

 

Sales Rep > Prospects > Workups > Submit Agreement 

Sales Reps > Buyers > Agreement & Sales Management > Manage Buyers & SPECs > Agreement 

 

 

Sales Rep > Prospects > Workup > Select Options, and Sales Rep > Buyers > CO > New & Edit 
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Sales Rep > Prospects > Workups > Rebate 

Sales Management > Manage Buyers & SPECs > Agreement > Rebate 
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Addition of attributes to options 

Defect #:  001-00-1-10418 

Ticket #:   

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   Data Library > Options > Edit > Attributes 

Sales Rep > Prospects > Workups > Select > Options 

Sales Rep > Buyers > CO > Edit 

- Attributes can now be added to options. Each option can have 2 attributes, with 

multiple selections per attribute 

- The attributes are defined for each option at the Data Library > Options level 

- Attributes and Attribute selections that are active (not archived) will shown as drop 

downs on the select option screens for workups and change orders 

- Detail for the attributes will be shown on purchase orders next to selection notes in 
the option details section.  

Screenshots:  
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Ability to transfer workups from one lot to another in the project 

Defect #:  001-00-1-9184 

Ticket #:  001-00-148660, 001-00-152209 

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   Sales Rep > Prospects > Workups > Transfer Workups 

Workups that have not yet been submitted can now be transferred to other lots in the 

same project. The new lot must offer the same plan, and not yet have a SPEC. The user 

will be offered a chance to cancel the process if there are lot-dependent options on the 

workup, since those cannot be transferred to the new lot. 

Screenshots:  
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Ability to enter cents in the Differential/Delta field to adjust the final price on sales contracts 

Defect #:  001-00-1-9767 

Ticket #:  001-00-147509 

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   Sales Rep > Prospects > Workups > Submit Agreement 

Sales Management > Manage Buyers & SPECs > Agreement Submitted 

Cents can now be entered in the Differential/Delta field to allow adjustment of the final 
price on sales contracts. 

Screenshots:  

 

 

 

New HTML email editor that incorporates BuildTopia tags 

Defect #:  001-00-1-10349 

Ticket #:   

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   Documents > Compose Email Template 

Documents > Profile > Edit (for email documents) 

A new HTML editor has been added to the Documents module that is easier to use, and 

that incorporates the BuildTopia tags that are available for emails. This will help prevent 

errors from incorrectly typed tags, and make it easier to create HTML email templates. 

Screenshots:  
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Lot address is displayed on the lot drop-down when creating new workups 

Defect #:  001-00-1-9076 

Ticket #:  001-00-149088 

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   Sales Rep > Prospects > Workups > Create New Workup 

The lot address is now displayed on the lot drop-down when creating new workups in 
addition to the lot number to make it easier to find lots. 

Screenshots:  
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New sales permission to control the ability to edit and remove agreement contingency dates  

Defect #:  001-00-1-10188 

Ticket #:  001-00-150428 

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   Sales Rep > Buyer > Agreement Submitted, Agreement Countered & Agreement Accepted 

Sales Management > Manage Buyers & SPECs >Agreement Submitted, Agreement 
Countered, & Agreement Accepted 

A new sales permission has been added called ‘Edit/Remove Contingency Dates.’ Users 

with a sales role that contains this permission are able to edit and remove the contingency 
date on agreements with the statuses specified above.  

To remove the contingency date, click Edit, delete the date, and click Save. 

Screenshots:  
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New sales permission to control the ability to edit agreement contract dates  

Defect #:  001-00-1-10346 

Ticket #:   

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   Sales Rep > Buyer > Agreement Accepted & Agreement Finalized 

Sales Management > Manage Buyers & SPECs >Agreement Accepted & Agreement 
Finalized 

A new sales permission has been added called ‘Edit Agreement Dates.’ Users with a sales 

role that contains this permission are able to edit the agreement contract date on 
agreements that are in the ‘Agreement Accepted’ and ‘Agreement Finalized’ statuses. 

Screenshots:  
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New filters on the Buyers list is Sales Rep 

Defect #:  001-00-1-9988 

Ticket #:   

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   Sales Rep > Buyers 

The following filters were added to the Buyers list in Sales Rep were added to make it 
easier to find and sort buyers: Plan, Sales Status & Construction Status 

Screenshots:  

 

 

 

New project management permission to control the ability to perform SPEC to PA 

conversions  

Defect #:  001-00-1-10084 

Ticket #:  001-00-151529 

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   Project Management > Lot Matrix 

A new project management permission has been added called ‘Complete SPEC to PA 

Process.’ Users with a project management role that contains this permission are able to 

perform the SPEC to PA conversion process which consolidates SPEC and Purchase 
Options and NSOs for SPECs under construction that have been sold. 

Screenshots:  
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Ability to select projects when creating contracts from a Unit of Measure bid 

Defect #:  001-00-1-10074 

Ticket #:   

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   Bidding & Contracting > Bids > Unit Of Measure > View > Create Contract 

When generating contracts from unit of measure bids that are associated to multiple 
projects, users can now select the projects that should receive new contracts. 

Screenshots:  

 

 

 

Addition of a warning message when ‘All Plans’ is selected when updating turnkey bids and 

contracts 

Defect #:  001-00-1-10075 

Ticket #:  001-00-151533 

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   Bidding & Contracting > Bids > Turnkey > Edit 

Bidding & Contracting > Contracts > Turnkey > Edit 

A warning message will now be shown when ‘All Plans’ is selected for base or option 

activities on turnkey bids or contracts, to prevent erroneous updates. The user can click 
‘OK’ to save on all plans.  

Screenshots:  
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Password reset on the Homebuyer Homepage 

Defect #:  001-00-1-10348 

Ticket #:   

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   Homebuyer Homepage > My Profile 

Owners can now reset the passwords for their Homebuyer Homepages on their own. 

Screenshots:  
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New tags for emails and contracts 

Defect #:  001-00-1-9072, 001-00-1-10108, 001-00-10288 

Ticket #:  001-00-152023, 001-00-151553 

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   The following new tags have been added: 

• @@net_taxes@@ 

• @@net_taxes_text@@ 

• @@purchase_price@@ 

• @@purchase_price_text@@ 

• @@purchase_price_minus_deposits@@ 

• @@purchase_price_minus_deposits_paid_and_unpaid@@ 

• @@total_price_with_taxes@@ 

• @@total_price_with_taxes_text@@ 

• @@total_rebates@@ 

• @@total_rebates_text@@ 

• @@total_taxes@@ 

• @@total_taxes_text@@ 

• @@project_company_name@@ 
• @@owner_primary_contact@@ 

 

Usability updates to the Customer Service Module 

Defect #:  001-00-1-9984, 001-00-1-9986, 001-00-1-9987 

Ticket #:   

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   In an effort to make information easier to see and find in the Customer Service module 

the following updates have been made: 

• Service Orders tab: Re-organization of columns and addition of a Project filter 

• CS Home > Unassigned Requested tab: Re-organization of columns 
• Owners tab: Re-organization of columns 

 

Usability updates to the Trade Partner accounts 

Defect #:  001-00-1-9994, 001-00-1-10016, 001-00-1-10036, 001-00-1-10037, 001-00-1-10470, 

001-00-1-10471, 001-00-1-10472, 001-00-1-10520, 001-00-1-10540 

Ticket #:  001-00-1511128 

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   In an effort to make information easier to see and find in Trade Partner accounts the 

following updates have been made: 

• The Lot Address has been added to the following screens: Purchase Orders, NSO 

Quotes, and Invoices. 

• Lot Number and Address search fields have been added to the Purchase Orders list 

• Project and Trade filters have been added to the Bid Invitations section of Bids 

• The column orders on the Purchase Order tabs have been reformatted to show 

information more clearly 

• A Project filter has been added to the Service Orders tab 
• A Project filter has been added to the NSO Quotes tab 



© 2012 Constellation HomeBuilder System, Inc.  All rights reserved.   18 

Defect Fixes 

This section highlights corrections and defect fixes that have been applied to BuildTopia. Each item is 

identified by a ticket and / or defect number (where applicable) which tracks to our internal support and 

software development system. The product versions affected are listed with each item. There is also a 

description of the item with any relevant screenshots to detail the defect. 

 

Prevention of double-clicking of the create and approve schedule links 

Defect #: 001-00-1-10390 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Project Management > Lot Matrix > Create Schedule > Calculate Schedule 

Project Management > Lot Matrix > Review Schedule > Approve Construction Schedule & 
Approve Pre-Construction Schedule 

The links mentioned above have been adjusted to prevent double-clicking to prevent 

creation of duplicate schedules on lots. 

 

Issue with duplicate prospect/buyer checking functionality 

Defect #: 001-00-1-10398 

Ticket #: 001-00-152242 

  BTBuilder             BTSales              BTService              BTLead 

Description: Sales Rep > Prospects > Add Prospect 

When a buyer was presented as the results of the duplicate checking functionality, it was 
possible to create a new workup for the existing buyer. This has been corrected. 

 

Validation of prospect and buyer email addresses 

Defect #: 001-00-1-10519 

Ticket #: 001-00-152549 

  BTBuilder             BTSales              BTService              BTLead 

Description: Sales Rep > Prospects > Add Prospect & Edit 

Sales Rep > Buyers > Buyer Name > Edit 

Sales Management > Manage Buyers & SPECs > Buyer Name > Edit 

Customer Service > Owners > Owner Name > Edit 

Text entered into the email address fields on the above screens will be checked to ensure 
that saved entries are in a valid email format. 

Validation of the text field for Addenda 

Defect #: 001-00-1-10339 

Ticket #: 001-00-151503 

  BTBuilder             BTSales              BTService              BTLead 

Description: Sales Rep > Buyers > Addenda > New & Edit 

Sales Management > Manage Buyers & SPECs > Addenda > New & Edit 

Validation of the Addenda text field has been updated to accept up to 4000 characters. 
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Issues when generating sales contracts while using Internet Explorer 

Defect #:  001-00-1-9570 

Ticket #:  001-00-149838, 001-00-150025 

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   An addition pop-up box was sometimes shown when generating sales contract documents 

while using Internet Explorer. This has been corrected. 

 

Issues when trying to print the screen when using Internet Explorer 

Defect #: 001-00-1-9884 

Ticket #: 001-00-150905, 001-00-151084, 001-00-151528, 001-00-152382 

  BTBuilder             BTSales              BTService              BTLead 

Description: Some users were experiencing issues when trying to print BuildTopia screens when using 

Internet Explorer. This has been corrected. 

 

Issue with the display of tax on Turnkey Bids in Trade Partner accounts 

Defect #: 001-00-10420 

Ticket #: 001-00-152332 

  BTBuilder             BTSales              BTService              BTLead 

Description: Trade Partner Account: Home > Bid > View 

In some cases tax, although correctly calculated, was not displayed on the view screens for 
some turnkey bids. This has been corrected. 

 

Missing documents column on the ‘All’ tab for Purchase Orders in Trade Partner accounts 

Defect #: 001-00-10214 

Ticket #: 001-00-151812 

  BTBuilder             BTSales              BTService              BTLead 

Description: Trade Partner Account: Home > Purchase Orders 

The documents column was missing from the ‘All’ tab for Purchase Orders in Trade Partner 
accounts. This has been corrected. 

 

Issues with project name shown on month schedule views in Trade Partner accounts 

Defect #: 001-00-10521 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Trade Partner Account: Home > Schedules 

The project name was not shown on the month schedule for Trade Partners if they 
navigated to different weeks using the ‘Next’ and ‘Previous’ links. This has been corrected. 
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BuildTopia Product Roadmap 

These are some of the new features and enhancements scheduled for future releases in 2013. This 

information is not a complete list of all features that will be in the releases, and is subject to change. If 

you have any suggestions in these areas, please contact the Customer Support Desk.  

  

Version 6.3.0, Release date March 5th 2013 

Focus – Sales and Bidding & Contracting 

 

• Improve cross-project functionality for updating information in Bidding and Contracting 

• Combine Sales Rep and Sales Management modules, with advanced permissions 

• Improved sales incentives functionality. 

 

Version 6.4.0, Release date July 23rd 2013 

Focus – User interface re-design 

 

• Updated design theme 

• Improved, intuitive workflows 

• Tablet browser friendly screens. 


